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1 Introduction
This document describes integration between Rational Synergy and Rational Team Concert (RTC) where Synergy tasks can be linked directly to RTC work items, work items can be displayed, queried and linked from inside Rational Synergy client.

Enabling the integration requires two steps:

· Install Rational Synergy 7.2.1.4
· Install Rational Synergy for RTC Interface 1.2.0.0 iFix001, which has several components that must be installed individually. 

2 System Requirements & Installation Instructions

Refer to the document “IBM Rational Synergy for Team Concert Interface 1.2.0.0 iFix001 Readme” for system requirements and installation instructions.
3 How the Integration Works

3.1 Rational Synergy
Once this integration is enabled on the Synergy client, RTC work items will be reflected in place of Rational Change change-requests. For example:

· Change Requests Explorer Pane
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· Change Request Tab on Task Properties Dialog 

[image: image2]


· Query Dialog (Find Change Requests)
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The appearance of the Rational Synergy client was not changed at all for this integration.  Because Rational Synergy tasks can be linked with both Rational Change change-requests and RTC work items, no labels were modified.  “Change Request” is considered as a generic term that can refer to either a CR or a work item.

To distinguish RTC work items from Rational Change change-requests, an attribute (pseudo-attribute) called cr_tool_displayname can be displayed, which will display “Change” or “IBM Rational Team Concert (<projectarea_name>)”.  Since a single Synergy task can be linked to both work items and Rational Change change-requests, it is useful to add this attribute as a column in views such as, Change Request Tab on Task Properties Dialog.

3.2 Rational Team Concert

RTC work items stores OSLC URLs of linked Synergy tasks.  If the link is followed, post the authentication, a web dialog showing Synergy task properties and associated objects with the task is displayed. From the task properties page, user can open Rational Synergy rich client by clicking the “Show Properties Dialog” button.  To bring up the task properties dialog from the web dialog, the user must have the Rational Synergy client installed locally.  

· Example -RTC work item displaying linked Synergy tasks:
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· Example - Task properties web page:
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3.3 Using Synergy with RTC and Rational Change

There is a notion of a single “active change request tool”; this is the tool where queries will be run.

However, Rational Synergy database can contain both Rational Change change-requests and RTC work items. Rational Synergy distinguishes Rational Change change-requests and RTC work items and provides all normal operations on them.  For example, opening a work item will open RTC and opening a CR will open Rational Change.  Synergy tasks can be associated to change requests from both RTC and Rational Change, so under the “Change Requests” tab of task properties, all associated change requests are displayed together and the user can still operate on them.
3.3.1 Change Requests from Rational Change
The change requests managed by Rational Change are unaffected by RTC integration. Rational Change change-requests continue to have a cvtype=’problem’ and all objects with that cvtype are managed by Rational Change.
3.3.2 Change Requests from Rational Team Concert

Change Requests for RTC use reference (proxy) objects. Those proxy objects shall have “_cr_” as the cvtype. The change requests that belongs to Rational Change or RTC (multiple project-areas) can be distinguished, by the attribute “cr_tool_displayname”.  
3.4 Proxy Objects

In order to support nested queries, work items that are related to tasks are represented by proxy objects (or “ghost work items”) inside the Synergy database.  A proxy object has the following attributes by default:

· tool (string) – the name of the change request tool to which this object belongs to. (e.g., “rtc”)
· url (string) – the URL of the change request this object references.

Note: If the RTC server is moved, the URLs stored in this field needs to be updated to reflect the new server location.

· name (string), version (string), type (string), subsystem(string) – these four attributes comprise a Synergy object’s unique four-part name. 

· Change requests are not versioned, so the value of version is always “1”. 

· The type is “_cr_”.
· The subsystem (instance) is the name of the change request tool. (e.g., “rtc”)
· The name is chosen to be unique for the specified change request tool. For RTC, this is “<tool-name>_<work item number>”, for example, rtc_123000.

For example, the four-part name of a reference to an RTC work item would be “rtc_123000:1:_cr_:rtc” (or internal notation “rtc/_cr_/rtc_123000/1”).

The following additional attributes are defined for work items:

· problem_synopsis (string) – Short description.

· description (text) – Detailed description.

· problem_number (string) – Change request tool defined identifier.

· crstatus (string) – Current status in the change request tool lifecycle.

· owner (string) – The person responsible for the change request.

· resolver (string) – The person to whom the change request is assigned.

· release (string) – The release where the change request will be resolved. As this does not map well between Synergy and RTC, this is not set. See “planned_for”.

· priority (string) – The priority of the change request as defined in the change request tool.

· create_time (time) – The time the change request was created.

· planned_for (string) – RTC specific attribute specifying the iteration where the work item will be resolved. See “release”.

· cr_can_associate_task (boolean) – Can associate a task to the change-request. It defaults to TRUE, which means the task can be associated to the change request.

· cr_can_disassociate_task (boolean) – Can disassociate a task from the change-request. It defaults to TRUE, which means the task can be disassociated from the change request.

· request_type (string) – Change request type.

These values are copies of the data maintained in RTC and serve as cached values which can be used in Synergy queries. More work item properties can be mapped to attributes in the reference objects. Refer to section “Configure cached attributes for proxy work items” for configuring the cached attributes.

By using reference objects, the existing logic that Synergy uses for Rational Change change-requests can be leveraged. A task is associated with an RTC work item by creating a relationship from the RTC work item’s reference object to the task with the name “associated_task” just as is done for Rational Change change-requests, and all logic that evaluates the “associated_task” relationship functions normally.

3.5 Queries
New query functions are available to invoke a query remotely in RTC.

crquery(“<query string>”)

This function takes one string argument which is the name of a shared query in RTC, for example, “Open assigned to me”.  The query is run remotely on RTC, and the returned results are displayed in Synergy.
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Users can create saved queries in Rational Synergy for the RTC shared queries and add those saved queries to the Change Request Explorer pane on the main view.  When the query is executed, all the work-items returned from RTC shall be displayed in Synergy, where as Synergy CLI client shall display only the work-items which has the respective proxy objects available.  Queries performed in the GUI are not limited to work items with an existing reference object; this allows users to link tasks with work items not yet referenced from the Synergy database.

Note: The query name must be RTC shared query name.  User-defined RTC queries cannot be referenced.

3.6 Policies

3.6.1 Work Item Completion requires Linked Tasks to be Complete
RTC work-item completion mandates all the linked (that is, associated) Synergy tasks to be completed before the work-item can be marked as complete.
3.6.2 Task Completion requires Linked Work Item

Rational Synergy can be configured to allow task completion, only for tasks that have an associated work item (change request) by creating an attribute named “required_attributes” of type text on the task cvtype with the value “change_request”.

The keyword “change_request” is called as “pseudo attribute”; the attribute does not physically exist.  When checking for required attributes, Synergy interprets the “change_request” keyword by asking “is this task referenced by any has_associated_task relationships?”

4 CLI Commands

The following commands has been introduced in Synergy 7.2.1.4 release and shall not be available in prior releases.
4.1 ccm crtool –init
This command can be used to configure a new change-request tool for the database. This command must be run in single user admin mode and requires the current role to be set as “ccm_admin”. 

More than one RTC project-area can be integrated with the same Synergy database. This feature is available in Synergy 7.2.1.4 release onwards. For each RTC project-area integration, the “ccm crtool –init” command needs to be executed.

Command Syntax:

ccm crtool -init tool_name 
-url|-rtc_server_url url 
-pa|-rtc_project_area_name project_area_name 
-admin|-rtc_admin username 
([-pw|-rtc_admin_password password] | [-pwprompt]) 
[-tool_displayname displayname] 
[(/types|/allowed_wi_types_to_link types,...)...] 
[(/states|/allowed_wi_states_to_link states,...)...]
[(/cache|/cache_attributes attr_names,...)...] 
[-default] ([/active] | [/inactive])
-init tool_name
Specifies the change-request tool name to be used for the integration. The name should be unique across the databases in the DCM cluster and should follow Synergy naming conventions. The maximum allowed characters for the tool name is 16 characters and it cannot contain non-ASCII characters. By default, the tool-name is converted to lower case. Prior to 7.2.1.4 release, the Synergy database configured with RTC has the default tool name as “rtc”. Since Synergy supports to configure more than one RTC project-area to a single Synergy database, this option can be used to specify the tool-name while configuring the database. The proxy objects created for this integration, shall have the instance as this tool-name.

-url|-rtc_server_url url
Specifies the RTC server url where the project-area to be configured with the Synergy database resides. 

-pa|-rtc_project_area_name project_area_name
Specifies the RTC project-area name which needs to be configured with Synergy database.

-admin|-rtc_admin username
Specifies the RTC user name who has the administrative privileges in the project-area. Synergy uses this account to query and modify the work-items.
([-pw|-rtc_admin_password password] | [-pwprompt])
Specifies the RTC user’s password.
[-tool_displayname displayname]
Specifies the display-name for the change-request tool. This name shall be used in user display messages where ever applicable. If not specified, then it defaults to “IBM Rational Team Concert (<project_area_name>)”.
[(/types|/allowed_wi_types_to_link types,...)...]
Specifies the allowed RTC work-item types which shall be allowed to associate Synergy tasks. More than one type can be specified by comma separated values. If not specified then all the types are allowed.
[(/states|/allowed_wi_states_to_link states,...)...]
Specifies the allowed RTC work-item states which shall be allowed to associate Synergy tasks. More than one state can be specified by comma separated values. If not specified then all the states are allowed.
[(/cache|/cache_attributes attr_names,...)...]
Specifies the list of attributes to be cached as part of the proxy objects apart from the default list of mapped attributes. More than one attribute can be specified by comma separated values. If not specified then only the default set of attributes shall be cached. Refer to the section Proxy Objects for the default set of attributes created on Synergy proxy objects.

The option value should be in the following format: <rtc_attribute_id>[:<synergy_attribute_name>]
· <rtc_attribute_id>, is the attribute identifier on RTC work item. 

· <synergy_attribute_name>, is the attribute name which gets created on Synergy proxy object. Providing Synergy attribute name is optional and if omitted then RTC work item attribute identifier shall be used as Synergy attribute name for the proxy object.

[-default]
Specifies whether the tool needs to be set as database default tool or not. By default, the tool shall not be set as database default tool.
([-active] | [-inactive])
Specifies whether the tool needs to be enabled/disabled for the users. By default the tool shall be enabled and users can integrate with the tool.

Example:
· ccm crtool –init demo1 –url https://rtcserver.com:9443/ccm -pa “First PA” –admin admin1 –pwprompt
Configures a new change-request tool with name “demo1” for the project-area “First PA”. The tool shall be set as active by default, but not as database default.

· ccm crtool –init demo2 –url https://rtcserver.com:9443/ccm -pa “Second PA” –admin admin2 –pwprompt –default –active

Configures a new change-request tool with name “demo2” for the project-area “Second PA”. The tool shall be set as active and database default.

· ccm crtool –init demo3 –url https://another_rtcserver.com:9443/ccm -pa “Third PA” –admin admin3 –pwprompt -inactive

Configures a new change-request tool with name “demo3” for the project-area “Third PA”. The tool shall be set as inactive. No users can integrate with this tool until it is marked as active.
4.2 ccm crtool –modify
Command to modify the existing change-request tool configurations. This command must be run in single user admin mode and requires the current role to be set as “ccm_admin”. 

The tool name for Rational Change integration is “cs”. Only “–default, –active and –inactive” options are allowed for modifying Rational Change tool configurations.

Command Syntax:

ccm crtool -m|-modify tool_name 
[-url|-rtc_server_url url]
[-pa|-rtc_project_area_name project_area_name]
[-admin|-rtc_admin username]
([-pw|-rtc_admin_password password] | [-pwprompt]) 
[-tool_displayname displayname] 
[(/types|/allowed_wi_types_to_link types,...)...] 
[(/states|/allowed_wi_states_to_link states,...)...]
[(/cache|/cache_attributes attr_names,...)...] 
[-default] ([/active] | [/inactive])
-m|-modify tool_name
Specifies the change-request tool, which needs to be modified. The specified tool-name should be one of the existing tools configured in the database.

[-url|-rtc_server_url url]
Specifies the new RTC server url where the project-area to be configured with the Synergy database resides. This option shall update the RTC server URL stored in the admin object only and shall not update the URLs stored in the proxy objects. If the URL in the proxy objects needs to be updated then follow the section Server Rename.
-pa|-rtc_project_area_name project_area_name
Specifies the new RTC project-area name which needs to be configured with Synergy database.

[-admin|-rtc_admin username]
Specifies the new RTC user name who has the administrative privileges in the project-area. Synergy uses this account to query and modify the work-items.

Note: The RTC admin user information shall be stored in the $CCM_HOME/etc/ccm.crtool.<tool_name>.properties file. If the file does not exist, then using this option shall recreate the properties file.
([-pw|-rtc_admin_password password] | [-pwprompt])
Specifies the RTC user’s password.
[-tool_displayname displayname]
Specifies the new display-name for the change-request tool.
[(/types|/allowed_wi_types_to_link types,...)...]
Specifies a new list of RTC work-item types which shall be allowed to associate Synergy tasks. More than one type can be specified by comma separated values. Note, the existing values shall be overwritten.
[(/states|/allowed_wi_states_to_link states,...)...]
Specifies a new list of RTC work-item states which shall be allowed to associate Synergy tasks. More than one state can be specified by comma separated values. Note, the existing values shall be overwritten.
[(/cache|/cache_attributes attr_names,...)...]
Specifies a new set of attributes to be cached as part of the proxy objects apart from the default set of attributes created on Synergy Proxy Objects. More than one attribute can be specified by comma separated values. Note, the existing values shall be overwritten.
The option value should be in the following format: <rtc_attribute_id>[:<synergy_attribute_name>]
· <rtc_attribute_id>, is the attribute identifier on RTC work item. 

· <synergy_attribute_name>, is the attribute name which gets created on Synergy proxy object. Providing Synergy attribute name is optional and if omitted then RTC work item attribute identifier shall be used as Synergy attribute name for the proxy object.

[-default]
Specifies whether the tool needs to be set as database default tool or not.
([-active] | [-inactive])
Specifies whether the tool needs to be enabled/disabled for the users.
4.3 ccm crtool –list
Command to list the installed change-request tools in the database. The output of this command would have the following format: %name %displayname %rtc_projectarea %url %active %default 

Here, 

· %name, is the change-request tool name
· %displayname, is the change-request tool’s displayname
· %rtc_projectarea, is the RTC project area name used by this tool 

· %url, is the RTC server url used by this tool
· %active, mentions whether the integration is active, that is the tool is enabled to integrate or not
· %default, mentions whether the change-request tool is database default tool
Command Syntax:

ccm crtool -l|-list ([-active] | [-inactive])

-l|-list

Lists all the change-request tools configured in the database. By default both the active and inactive (that is, integration enabled and disabled) change-request tools shall be listed.

[-active]
If specified only the active change-request tools shall be listed.

[-inactive]
If specified only the inactive change-request tools shall be listed.

Example:

· ccm crtool –list
Name  Displayname                          RTC Project-area Url                                    Active  Default

cs    IBM Rational Change                  N/A              N/A                                    FALSE   FALSE
demo1 IBM Rational Team Concert (First PA) First PA         https://rtcserver.com:9443/ccm         TRUE    TRUE

demo2 RTC - Second PA                      Second PA        https://rtcserver.com:9443/ccm         TRUE    FALSE
· ccm crtool –list –active
Name  Displayname                          RTC Project-area Url                                    Active  Default

demo1 IBM Rational Team Concert (First PA) First PA         https://rtcserver.com:9443/ccm         TRUE    TRUE

demo2 RTC - Second PA                      Second PA        https://rtcserver.com:9443/ccm         TRUE    FALSE
· ccm crtool –list –inactive
Name  Displayname                          RTC Project-area Url                                    Active  Default

cs    IBM Rational Change                  N/A              N/A                                    FALSE   FALSE
4.4 ccm crtool –show

Command to show the change-request tool’s properties.

Command Syntax:

ccm crtool –s|-sh|-show tool_name
Example:

· ccm crtool –show demo1
Change Request Tool Information:

        Name:                     demo1
        Displayname:              IBM Rational Team Concert (First PA)

        Active:                   Yes

        Database Default:         Yes
        Tool Server Url:          https://rtcserver.com:9443/ccm

        Project-area Name:        First PA

        Allowed Work-item Types:

                          Enhancement
                          Defect
        Allowed Work-item States:

                          In Progress                         

                          Reopened
        Custom Mapped Attributes:

                          rtcattr1

                          rtcattr2
4.5 ccm crtool –default
Command to show the change-request tool used by the current Synergy session. 
Command Syntax:

ccm crtool –default
Example:

· ccm crtool –default

demo1 IBM Rational Team Concert (First PA)

5 Administration
5.1 Restrict which work item types can link to tasks

Users can configure which work item types can be linked to Synergy tasks.  By default, all the work item types can be linked to Synergy tasks. This can be changed to allow only certain work item types to be linked to Synergy tasks by specifying the option “-types|-allowed_wi_types_to_link types”, while configuring the database for RTC or after configuring the database for RTC. 

For example, if Synergy tasks need to be linked only to work items of type "Story" or "Enhancement" or "Defect", then the value of this option should be as follows:
· ccm crtool –init demo1 –url https://rtcserver.com:9443/ccm -pa “First PA” –admin admin1 –pwprompt –types Story,Enhancement –types Defect
· ccm crtool –modify demo1 –types Story,Enhancement –types Defect
5.2 Restrict which work item states can link to tasks

Users can configure which work item states can be linked to Synergy tasks.  By default, all the work item states can be linked to Synergy tasks. This can be changed to allow only certain work item states to be linked to Synergy tasks by specifying the option “-states|-allowed_wi_states_to_link states”, while configuring the database for RTC or after configuring the database for RTC. 

For example, if Synergy tasks need to be linked only to work items in the states "In Progress" or "Reopened", then the value of this option should be as follows:

· ccm crtool –init demo1 –url https://rtcserver.com:9443/ccm -pa “First PA” –admin admin1 –pwprompt –states “In Progress, Reopened”
· ccm crtool –modify demo1 –states “In Progress” –states Reopened
5.3 Configure cached attributes for proxy work items

Users can configure a list of attributes that needs to be synchronized from RTC work item to Synergy proxy objects, when the proxy object gets created in Synergy. This can be achieved by specifying the option “-cache|-cache_attributes attr_names” while configuring the database for RTC or after configuring the database for RTC. For example,

· ccm crtool –init demo1 –url https://rtcserver.com:9443/ccm -pa “First PA” –admin admin1 –pwprompt –cache “rtcattr1, rtcattr2:synattr” –cache rtcattr3
· ccm crtool –modify demo1 –cache “rtcattr1, rtcattr2:synattr” –cache rtcattr3
5.4 Server Rename

If the RTC server is relocated to a different location, then all the references to this URL on the proxy objects in Synergy should be updated. This can be achieved by executing ”ccm update_urls” CLI command. Synergy CLI should be started in single user admin mode and the role should be set to ccm_admin to execute this command. 
Command Syntax:

    ccm update_urls /rtc [/tool_name tool_name]
        /old_url old_server_url /new_url new_server_url 
        attribute_name...
[–tool_name tool_name]
Specifies which tool’s proxy objects needs to be considered. If not specified then all the proxy objects shall be considered, that is all the objects with type “_cr_” shall be considered.
-old_url old_server_url
 Specifies the old server url, which needs to be corrected.
-new_url new_server_url
Specifies the new server url to be set on the proxy objects.

attribute_name...
Specifies the set of attribute names that needs to be considered to be updated.

Example:
ccm update_urls –rtc –tool_name demo1 -old_url https://rtcserver.com:9443/ccm -new_url https://new_rtcserver.com:9443/ccm urlattr1 urlattr2
5.5 Change Request Tool Admin Object

Once the database is configured for RTC, there shall be a change request tool admin objects created to hold the configuration details of the integration. By default the admin object for Rational Change tool shall be present in the database. The admin object for Rational Change has the four-part name cs:1:admin:1. The admin object for RTC has the four-part name <toolname>:1:admin:1. Here the <toolname>, shall be the change request tool name used while configuring the database for RTC. Prior to 7.2.1.4 release, the tool name defaults to “rtc”. The following attributes are common to all change request tool admin objects:

· pt_app (string) – Existing attribute from Change. The base URL of the change request tool. This is the URL which is invoked in a browser when the “Tools -> Start IBM Rational Change or Tools -> Start IBM Rational Team Concert” menu item is selected.  
Note: If the RTC or Change server is moved, this URL would need to be updated. Check Server Rename section for more information.

· integration_enabled (boolean) – Existing attribute from Change. TRUE when the integration is available in the Synergy GUI. When FALSE, the change request features are hidden.

· tool_displayname (string) – The name to be displayed for the pseudo-attribute cr_tool_displayname on reference objects for this tool. This attribute is new and does not exist for Change’s admin object. Prior to 7.2.1.4 release, the value defaults to the string “RTC”. As multiple project-area configuration is supported from 7.2.1.4 release onwards, the attribute shall have the default value as “Rational Team Concert (<rtc_project_area_name>)” and is configurable.
The admin object for RTC has a tool-specific attribute:

· rtc_project_area (string) – The name of the RTC project area this connection will access. Work items and saved queries that Synergy accesses belongs to this project area.

The admin object for Rational Change also has several attributes for managing all change request tools:

· installed_tools (string) – a list of all change request tools which have been configured for this database. The attribute value, that is the tool names shall be separated by vertical bar, “|”.

· default_tool (string) – the name of the change request tool that is used by default for the database.
5.6 Server Authentication

To support Rational Synergy server’s requirement to update RTC work items when the associated tasks are modified, the server needs authentication credentials for RTC. These credentials are stored in the properties file $CCM_HOME/etc/ccm.crtool.<tool_name>.properties. There are two user-editable keys in the properties file, crtool.<tool_name>.server.user and crtool.<tool_name>.server.password, which shall hold the user name and password respectively, of an RTC user who has sufficient privileges to modify Synergy task links on work items.

When the server reads the password property, it will replace with an encrypted password as a security measure.  To provide additional security, you can protect the file so that only ccm_root can read (and write) it.

From 7.2.1.4 release onwards, the CLI command “ccm crtool –modify” can be used to update the RTC username and password for the change-request tool. Also the property “crtool.<tool_name>.synergy.user”, shall take the current synergy user who executes the “ccm crtool –init” command as value in WINDOWS platform.
6 Client Features

6.1 User Configurable Change Request Tool

By default the users shall be allowed to integrate with the change-request tool which is configured as the default tool in the database. Users can override this behavior by configuring the tool that they want to integrate for their Synergy session. The property “crtool.user.tool.<db_name>=<tool_name>” in the properties file “$CCM_HOME/ccm.user.properties”, can be used to specify the user defined change-request tool. For example, the property “crtool.user.tool.demo_db=demo” shall integrate the change-request tool “demo” for all the Synergy sessions started for the database “demo_db” in that client machine.

6.2 Synergy CLI Client support for RTC
Rational Synergy CLI client shall support RTC work-items in the same way as Rational Change change-requests for all the supported commands. Only pre-requisite is, there should be a proxy object available in the database to perform the required operation. 
6.3 Synergy Developer Client support for RTC

Synergy developer client provides a new Change Request option dialog in which the users can configure the RTC user credentials, user defined change-request tool and so on.

To open the Change Request tools option, Select Tools -> Options and choose Change Request tab
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In the Default Tool section, it shows the default Database Defined tool. A user can override this value by specifying a User Defined tool. To set a user defined tool, select the tool name form that Available Tools list and click on Set as default button. Using the Properties section, the user can store the username and password for each tool in the available tools list. 

User can also set to prompt for a user defined tool each time on Synergy client startup. If Prompt for Change Request tool on Synergy client startup option is enabled, during the Synergy client startup it will bring up an additional dialog from which user can select the change request tool. 
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By clicking on the Cancel button, Synergy will use the default tool configured. 
7 References

· Upgrade RTC client libraries bundled with Synergy
8 Limitations and Known Problems
· Change-request tool name should be unique across databases in the DCM cluster. If not, the same server side properties file shall be shared between those connections.
· In client machine, if the RTC user information is configured for the current OS user. Any Synergy users starting a session for the database shall also use the configured RTC user credentials.

· If a database is moved (packed & unpacked) from one server to another, then all the configured change-request tool’s properties file needs to be copied to the new server. ($CCM_HOME/etc/ccm.crtool.<tool_name>.properties) Alternatively, the ccm crtool –modify command can be used to recreate the properties file.

· Rational Synergy server needs to be restarted once the database is configured for RTC.
· Only RTC shared queries can be used from Rational Synergy, user queries are not supported.

· The integration_enabled attribute on the cs admin object gets set to TRUE, when the Rational Change server is restarted.

· DCM for RTC change-requests is not supported.

· Baseline compare operation for RTC change-requests is not supported.

· Synergy client integrated with RTC, throws URE when the Synergy server is restarted.
· Synergy uses RTC 4.0 client libraries to integrate with RTC. As RTC servers allow the clients to be N-1 version, this integration would work with RTC 4.x and 5.x (verified with 5.0.2) server versions only. The RTC client libraries can be upgraded to later versions by following the tech-note “Upgrade RTC client libraries bundled with Synergy”. Upgrading the libraries would require thorough testing before using it in the production environment.
9 Contacting IBM Rational Software Support
If the self-help resources have not provided a resolution to your problem, contact IBM® Rational® Software Support for assistance in resolving product issues.

Note: If you are a heritage Telelogic customer, a single reference site for all support resources is located at http://www.ibm.com/software/rational/support/telelogic/
9.1 Prerequisites

To submit your problem to IBM Rational Software Support, you must have an active Passport Advantage® software maintenance agreement. Passport Advantage is the IBM comprehensive software licensing and software maintenance (product upgrades and technical support) offering. You can enroll online in Passport Advantage from http://www.ibm.com/software/lotus/passportadvantage/howtoenroll.html
· To learn more about Passport Advantage, visit the Passport Advantage FAQs at http://www.ibm.com/software/lotus/passportadvantage/brochures_faqs_quickguides.html.

· For further assistance, contact your IBM representative.

To submit your problem online (from the IBM Web site) to IBM Rational Software Support, you must additionally:

· Be a registered user on the IBM Rational Software Support Web site. For details about registering, go to http://www.ibm.com/software/support/.

· Be listed as an authorized caller in the service request tool.
9.2 Submitting problems

To submit your problem to IBM Rational Software Support:

1. Determine the business impact of your problem. When you report a problem to IBM, you are asked to supply a severity level. Therefore, you need to understand and assess the business impact of the problem that you are reporting.

Use the following table to determine the severity level.

	Severity
	Description

	1
	The problem has a critical business impact: You are unable to use the program, resulting in a critical impact on operations. This condition requires an immediate solution.

	2
	This problem has a significant business impact: The program is usable, but it is severely limited.

	3
	The problem has some business impact: The program is usable, but less significant features (not critical to operations) are unavailable.

	4
	The problem has minimal business impact: The problem causes little impact on operations or a reasonable circumvention to the problem was implemented.


2. Describe your problem and gather background information. When describing a problem to IBM, be as specific as possible. Include all relevant background information so that IBM Rational Software Support specialists can help you solve the problem efficiently. To save time, know the answers to these questions:

· What software versions were you running when the problem occurred?
To determine the exact product name and version, use the option applicable to you: 

· Start the IBM Installation Manager and select File > View Installed Packages. Expand a package group and select a package to see the package name and version number. 

· Start your product, and click Help > About to see the offering name and version number. 

· What is your operating system and version number (including any service packs or patches)? 

· Do you have logs, traces, and messages that are related to the problem symptoms? 

· Can you recreate the problem? If so, what steps do you perform to recreate the problem? 

· Did you make any changes to the system? For example, did you make changes to the hardware, operating system, networking software, or other system components? 

· Are you currently using a workaround for the problem? If so, be prepared to describe the workaround when you report the problem.

3. Submit your problem to IBM Rational Software Support. You can submit your problem to IBM Rational Software Support in the following ways:

· Online: Go to the IBM Rational Software Support Web site at https://www.ibm.com/software/rational/support/ and in the Rational support task navigator, click Open Service Request. Select the electronic problem reporting tool, and open a Problem Management Record (PMR), describing the problem accurately in your own words.
· For more information about opening a service request, go to http://www.ibm.com/software/support/help.html
you can also open an online service request using the IBM Support Assistant. For more information, go to http://www.ibm.com/software/support/isa/faq.html.

· By phone: For the phone number to call in your country or region, go to the IBM directory of worldwide contacts at http://www.ibm.com/planetwide/ and click the name of your country or geographic region. 

· Through your IBM Representative: If you cannot access IBM Rational Software Support online or by phone, contact your IBM Representative. If necessary, your IBM Representative can open a service request for you. You can find complete contact information for each country at http://www.ibm.com/planetwide/.

10 Notices
This information was developed for products and services offered in the U.S.A. IBM may not offer the products, services, or features discussed in this document in other countries. Consult your local IBM representative for information on the products and services currently available in your area. Any reference to an IBM product, program, or service is not intended to state or imply that only that IBM product, program, or service may be used. Any functionally equivalent product, program, or service that does not infringe any IBM intellectual property right may be used instead. However, it is the user's responsibility to evaluate and verify the operation of any non-IBM product, program, or service.

IBM may have patents or pending patent applications covering subject matter described in this document. The furnishing of this document does not grant you any license to these patents. You can send written license inquiries to:

IBM Director of Licensing 
IBM Corporation 
North Castle Drive 
Armonk, NY 10504-1785
U.S.A.

For license inquiries regarding double-byte character set (DBCS) information, contact the IBM Intellectual Property Department in your country or send written inquiries to:

IBM World Trade Asia Corporation 
Licensing 
2-31 Roppongi 3-chome, Minato-ku 
Tokyo 106-0032, Japan

The following paragraph does not apply to the United Kingdom or any other country where such provisions are inconsistent with local law:
INTERNATIONAL BUSINESS MACHINES CORPORATION PROVIDES THIS PUBLICATION “AS IS” WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. Some states do not allow disclaimer of express or implied warranties in certain transactions. Therefore, this statement may not apply to you.

This information could include technical inaccuracies or typographical errors. Changes are periodically made to the information herein; these changes will be incorporated in new editions of the publication. IBM may make improvements and/or changes in the product(s) and/or the program(s) described in this publication at any time without notice.

Any references in this information to non-IBM Web sites are provided for convenience only and do not in any manner serve as an endorsement of those Web sites. The materials at those Web sites are not part of the materials for this IBM product and use of those Web sites is at your own risk.

IBM may use or distribute any of the information you supply in any way it believes appropriate without incurring any obligation to you. Licensees of this program who wish to have information about it for the purpose of enabling: (i) the exchange of information between independently created programs and other programs (including this one) and (ii) the mutual use of the information which has been exchanged, should contact:

Intellectual Property Dept. for Rational Software 
IBM Corporation 
1 Rogers Street 
Cambridge, Massachusetts 02142
U.S.A.

Such information may be available, subject to appropriate terms and conditions, including in some cases, payment of a fee. 

The licensed program described in this document and all licensed material available for it are provided by IBM under terms of the IBM Customer Agreement, IBM International Program License Agreement or any equivalent agreement between us.

Any performance data contained herein was determined in a controlled environment. Therefore, the results obtained in other operating environments may vary significantly. Some measurements may have been made on development-level systems and there is no guarantee that these measurements will be the same on generally available systems. Furthermore, some measurements may have been estimated through extrapolation. Actual results may vary. Users of this document should verify the applicable data for their specific environment.

Information concerning non-IBM products was obtained from the suppliers of those products, their published announcements or other publicly available sources. IBM has not tested those products and cannot confirm the accuracy of performance, compatibility or any other claims related to non-IBM products. Questions on the capabilities of non-IBM products should be addressed to the suppliers of those products.

This information contains examples of data and reports used in daily business operations. To illustrate them as completely as possible, the examples include the names of individuals, companies, brands, and products. All of these names are fictitious and any similarity to the names and addresses used by an actual business enterprise is entirely coincidental.

If you are viewing this information softcopy, the photographs and color illustrations may not appear.
10.1 Trademarks

IBM, the IBM logo, ibm.com, Telelogic, Telelogic Synergy, Telelogic Focal Point, Telelogic DOORS, and Telelogic Change are trademarks or registered trademarks of International Business Machines Corporation in the United States, other countries, or both. These and other IBM trademarked terms are marked on their first occurrence in this information with the appropriate symbol (® or ™), indicating US registered or common law trademarks owned by IBM at the time this information was published. Such trademarks may also be registered or common law trademarks in other countries. A current list of IBM trademarks is available on the Web at www.ibm.com/legal/copytrade.html.

See copyright notices on the Web at http://www.ibm.com/legal/copytrade.html.

Microsoft, Windows, and/or other Microsoft products referenced herein are either trademarks or registered trademarks of Microsoft Corporation.

UNIX is a registered trademark of The Open Group in the United States and other countries.

Other company, product or service names may be trademarks or service marks of others. 
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